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JMPS Combat1 (JC1) and JMPS Combat Planning (JCP) Installation Instructions

1 Overview

These instructions cover installing the JC1 or JCP version of JMPS.  As a convention, when JC1/JCP is written, it implies that JC1 and JCP are interchangeable in the instructions.

To install JC1/JCP:

· Configure your system with the software listed in section 2 - Prerequisites.  

· If you have any previous version of JMPS installed (JC1, JCP, or JV1), uninstall it (see section 3 - Uninstall Previous Versions of JMPS).  You may not have more than one version of JMPS installed on a machine. 

· Complete the steps in the Pre Setup section to configure the system for JC1/JCP.

· Copy the JC1/JCP install package to your hard disk.  (Some machines have a security feature restricting the install from CD for COE, and installing over a network may time out or get interrupted, resulting in errors). 

· Install JC1/JCP (see section 5 - Installation)

· Complete the steps in the Post Setup section.

This document is divided into the following sections:

1  Overview – An overview of the process and document


2  Prerequisites – Software required to install and run JC1/JCP


3  Uninstall Previous Versions of  JMPS – Uninstall old software


4  Pre Setup – Configure machine for JC1/JCP 


5  Installation – Install JC1/JCP and the Mission Binder Repository


6  Post Setup – Configure application settings


7  Detailed Instructions – More detailed instructions for selected steps


8  Trouble Shooting – Solutions for selected error messages

2 Prerequisites

JMPS is targeted to run in a COE environment.  This version of JC1/JCP requires the COE Kernel and the COE Segments listed in the COE Configuration list below.  These segments are installed with the COE installer. 

However, you may also install JC1/JCP in a Non-COE environment.  This requires the software listed in the Non-COE Configuration below and a Security Stub (intended for developers).  

To set up a JC1/JCP server, you will need the Windows 2000 Advanced Server software listed in the Server Configuration section below instead of the Windows 2000 Professional software and you may choose to setup an FTP server and Roaming Profiles.

To install JC1/JCP, you will need the software listed in the JC1/JCP Software section below.

2.1 COE Configuration 4.6

COE - DII COE Kernel (Windows 2000) - 4.2.0.5

K42PXB - DII COE Kernel 4.2 Patch Version 4.2.0.0P8 (Patch 8)

W2KPTH – Windows 2000 Patch Update - 4.6.0.0/SP3-128bit* 

UPDTSL - COE Update System Security Level - 4.6.0.0

SECBNR - COE Security Banner - 4.6.0.0

W2KCET – MS Security Config Templates – 4.6.0.1

OFFICE - Microsoft Office 2000 Pro - 2000Pro

OFFICE - Microsoft Office Abbreviated Segment - 4.6.0.0

JAVA2 - Java Platform 2 - 4.7.0.0

PERL-1.0.0.4/5.005_3

JMU - JMTK Utilities Segment - 4.6.0.1

ACRORD - Adobe Acrobat Reader - 4.5.1.0

NAV - Norton Anti Virus - 4.5.3.0

NSWEB - Netscape Web Browser – 4.7.0.0

ONDOC – Online Docs – 4.2.0.0 (optional)

JAVA 1.4 - J2SE JRE 1.4 Segment (Includes Java WebStart)

JDK 1.3.1_02 The Java Development Kit (see section 7.1) – This is a non-COE segment temporarily required to run Mission Binders

2.2 Non-COE Configuration
Microsoft Windows 2000 Professional operating system with Service Pack

Microsoft Office 2000 with Service Release 2 (To verify you have MS Word Patch 2 installed, launch Word and select About Microsoft Word from the Help menu. Verify it says Microsoft Word 2000 (9.0.4402SR-1).

Microsoft Message Queuing (MSMQ) (see section 7.8)

ActivePerl 5.6.1 

Joint Mapping Tool Kit Utilities (JMU 4.5 - SDK) 

Web Browser with 128-bit encryption

JDK 1.3.1_02 The Java Development Kit (see section 7.1)

VBScript 5.6
· Note on VBSCRIPT: A VBScript 5.6 executable will be copied to the hard drive during the JC1/JCP install.  If, while installing JC1, you get the VBScript Version not correct message  (The version of VBScript installed on this machine appears to be lower than the version required by JMPS.), then navigate to the Program Files/JMPS/Setup/Scripts/scripten.exe.  Run the scripten.exe by double clicking on it.  (If you did not install to the default Program Files folder, navigate to your selected install folder). 

2.3 Server Configuration

Windows 2000 Advanced Server with 128-bit Encryption, with:

· Active Directory (see section 7.9)

· FTP Server (see section 7.5)

· Roaming Profiles (see section 7.6)

2.4 JC1/JCP Software

JC1- buildno, or JCP - buildno
MissionBinderRepository_1-0-0-3

MSDE2000SP2 (This is installed by the JC1/JCP Install if a version of MSDE is not already installed and named machinename/JMPS_SQL_Server)

PTWProtocolData.xml (secret file)

· The PTWProtocolData.xml file provides the capability to filter PTW imagery data on one additional piece of Meta-data.

· To obtain this file, please contact Jocelyn Alston at the PMA-233 program office. AlstonJM@navair.navy.mil
· When you receive this file, replace your existing PTWProtocolData.xml file, located in the dataInstallDir\DATA\local\JMPS\data\PTWData with the new one.

3 Uninstall Previous Versions of JMPS

Only one version of JMPS (JC1, JCP, JV1) may be installed at a time. If you have any version of JMPS installed, you must uninstall it before installing the new version. 

If you have an earlier version of JC1 than JC1 0.2 installed, you must un-attach the SQL databases manually before uninstalling/installing JC1/JCP, by running the DB Maintenance tool located in the Start->Programs->JMPS Admin menu and selecting the Detach DB tab.  This is done automatically for you in versions of JC1 0.2 or higher and all versions of JCP.

If you have the WXI (weather) Task Scheduler running, you must stop it manually before uninstalling Combat1.  The WXI Task Scheduler, if running, shows up in the Task Bar as a Cloud.  This is normally in the lower right hand side of the screen.  To stop the WXI Task Scheduler, Right Click on it and Select “Terminate WXI Task Scheduler”.

The following steps uninstall JC1/JCP:

1. Log on as machine administrator.

2. Go to your Start menu.  Select Settings\Control Panels\Add Remove Programs.

3. Un-install each of the following in this order:
· Combat1-Data
· Combat1

· JMPS-Combat1-Data

· JMPS-Combat1

You may optionally uninstall the following, they will be replaced automatically during install  (Uninstall suggested, if you have been having install problems):

· Data Change Notification - COM+ Component (optional) 

· Remote Subscriber Proxy - COM+ Component (optional)

· Event Subscription - COM+ Component (optional)

· MissionBinderRepository - COM+ Component (optional)

4. If you have an earlier version than MissionBinders 1.0.0.3 installed, then unattach the database and uninstall any earlier version (MissionBinders 1.0.0.1 or 1.0.0.2), by selecting Start->Settings->Control Panels->Add Remove Programs.

4 Pre Setup

1. Ensure you have the prerequisites installed (see Section 2 - Prerequisites. (To verify you have MS Word Patch 2 installed, launch Word and select About Microsoft Word from the Help menu. Verify it says Microsoft Word 2000 (9.0.4402SR-1).  Ensure that an Office product, such as Word, has been run on the machine at least once.

2. Set the Event Viewer logs to “Overwrite events as needed”.  

· Right-click on My Computer and select Manage.

· Expand the Event Viewer by clicking the +.

· Right-click on Application and select Properties.

· In the Log Size section select Overwrite Events as needed.

· Click OK.

· Repeat for the Security and System logs.

3. For those machines that are running as a JMPS server:

· You may optionally elect to set up Roaming Profiles (see section 7.6 - Setting up Roaming Profiles on the Server).

4. For those machines that will act as an FTP server (This will probably the JMPS Server):

· Set up and configure an FTP server (see section 7.5 - Install and Configure the FTP Server).

5 Installation (JC1/JCP and Mission Binders)

5.1 Install JC1/JCP

You will first install the program (in two parts and with four COM + components) and then the data (in two parts) (see Table 7‑2 for detailed instructions).  If you are installing from CD and get an error message saying Error Cannot find Data.cab, then copy the install file to your hard disk and install from there.  Some machines have a security feature restricting the install from CD usually for COE.  The JC1/JCP install will also install MSDE with SP2, if a version of MSDE is not already installed.  If you have an earlier version of MSDE, please uninstall it.  MSDE will be reinstalled automatically.  If you have a later version named machinename/JMPS_SQL_Server, the JC1/JCP install will use it.  To install JC1or JCP:

1. Log in as a machine administrator.

2. Copy the Build JC1/JCP-buildno folder to your hard drive.

3. Navigate to Build JC1/JCP-buildno/JMPS and select setup.exe.  

4. Select Next to start the Program Install.

5. Select the I accept the terms in the license agreement radio button and click Next.

6. Click Next, to accept the defaults. (If you are installing on a machine with a D hard drive, this will be the program default drive as prescribed by COE.  Otherwise it will be C). 

7. On the Client vs. Server screen, select the radio button associated with client, if you are installing on a client machine.  Select the radio button associated with server, if you are installing on a machine that will function as a JMPS data server. Click Next to continue with the install.

8. On the COE Security Settings screen, select the Yes radio button, if you want the COE/JMPS security policies installed. (This is permanent and will not be removed by un-installing JMPS.  It will lock down the machine).  Select the No radio button, if you do not want to apply the COE/JMPS security settings. Click Next to continue with the install.

9. Click Install, to start the Install.

10. Click Finish, to finish the JC1/JCP Program Install and automatically start the Data install.

11. Click Next, to start the Data Install.

12. Click Next to accept the defaults. (If you are installing on a machine with an E hard drive, this will be the Data default drive as prescribed by COE, otherwise it will be C).

13. Click Install, to start the Install.

14. If you do not have MSDE installed and named machinename/JMPS_SQL_Server, then at the end of the data install, MSDE with SP2 will be installed.

15. Click Finish, when the Completing the JMPS-Combat1-data Setup screen appears.

The JMPS databases should have been attached during the JC1 install.  You can manage the attaching and detaching of databases using the DB Maintenance tool installed with JMPS.  This can be accessed through the Start->Programs->JMPS Admin->DB Maintenance menu. If there has been a problem with attaching the databases, please use the DB Maintenance tool to attach and detach the databases. The following is a list of JMPS databases that are attached during the install:

· Aimpoints

· DAFIF

· JTIDS

· LocalPoints

· OrderOfBattle

· PointExport

· ThreatParameters

If you have problems with MSDE, then you may uninstall it via the Add/Remove Control Panel and re-install it using the MsdeInstallTool.exe located in the drive:\Program Files\JMPS\setup\MSDE folder.  If you get an error message stating unable to attach to multiple databases, determine if any of the above databases were not attached.  If one was not attached, navigate to the database and delete the databasename_log.ldf file associated with it. The databases are located in the InstallDir\data\local\jmps\data\databasename directory.

5.2 Install Mission Binders 

If you are installing the MissionBinderRepository_1.0.0.3 COE segment (COE environment), install via the COE Installer, otherwise install as described below.

1. Log in as a machine administrator.

2. Navigate to the MissionBinderRepository_1-0-0-3\Windows directory.

3. Double-click “setup.exe”.

4. “Install Anywhere” will appear in the Mission Binder window.

5. Click the “Next” button.

6. The “Where would you like to install?” prompt will appear.

7. The default value for this prompt is usually fine.  (However, if you are installing on a COE machine, install to the appropriate drive for program executables.  This will probably be the D drive.)

8. Click the “Next” button.

9. The “Choose a folder to store Mission Binder data files” prompt will appear.

10. You probably will want to change the location to a data directory, such as “drive:\data\local\MissionBinder\data”. Remember this path, you will need it to attach the database later.  (If you are installing on a COE machine, select install to the appropriate drive for data.  This will probably be the E drive.) 

11. Click the “Next” button.

12. Click the “Install” button.

13. The Mission Binder Repository will now be installed.

14. When the installation completes, click the “Done” button.

15. When the “Install was successful” message appears, select the “OK” button.

16. Reboot the computer.

To use Mission Binders, you must attach the MissionBinder database.  You may use the DB Maintenance tool installed with JC1.  This can be accessed through the Start->Programs->JMPS Admin->DB Maintenance menu.  Select the Attach DB tab, then select the Browse button and browse to the MissionBinder.MDF file located in the location you installed the MissionBinder data.  Then click the Attach Database button.

6 Post Setup

1. Security Stub: If you are not running on a COE machine (UPC Developers), you must register the developer’s security stub, JmpsSecurityUtilitiesStub.dll.  This is available on the China Lake site under UPC Devlopers/ToolsTestbed/Developer Security and Privilege stubs.  Do not register the Privilege stub for JC1 or JCP versions of JMPS.

2. COM+:  Configure the machine for COM+  (see section 7.4 - Set COM+ Communication Properties).

1. Set the COM Default Authentication Level to none on the machine (required for all users).  JMPS will not run if this is not set.  If you elect not do the next step, then reboot your computer now (see section 7.4.1 - Setting the Default COM+ Authentication Level).

2. Create a JMPS unique Windows user with Administrator authority and configure the JMPS COM+ applications to run as this user.  Reboot the computer (see section 7.4.2 – Setting a JMPS Unique Windows User and section 7.4.3 - Configure the JMPS COM+ Applications).  (If you are running on a stand-alone machine and will be running with administrator privileges you may skip this step.  Developers may choose to skip this step if they will always be running with Administrator privileges, but some client/server functionality may not be available).

3. Groups and Users:  The JC1/JCP Install will create the necessary JMPS local groups on the target machine.  Users must be added to these groups to be able to run JMPS.  The Administrator may wish to create domain groups and add users to the domain group.  If domain users and groups exist, they take priority (See section 7.3 - JMPS Security Role Configuration Instructions for the Development Environment).
4. JMPS Server: If you are installing to a Client/Server environment, to use Server walkaway, please make the following manual changes after you install JMPS:  On the machine functioning as the JMPS server, modify the JMPSPublisher service to run as an admin user.

· Right click on My Computer and select manage.

· Expand the Services and Applications tree.

· Select Services in the right window.

· Right click on the JMPSPublisher service and select properties.

· Select the Log On tab.

· Select the This account radio button.

· Browse to an admin account and provide the appropriate password.

· Click OK.

· Right click on the JMPSPublisher service and select restart.

5. PTW Server:  On hosts that will function as the JMPS PTW Server (typically the JMPS Server), configure the PTW Server. To receive data from the PTW server, you must point to a folder where the PTW information is to be put, and tell the PTW process where this folder is. You created this folder when you setup your FTP server for PTW in the Pre-Setup section. (i.e. C:\inetpub\ftproot). Edit the registry value located in HKLM\Software\JMPS\PTW\FtpPushPath and set it to the newly created folder.   To enable the PTW Service on the Server, Right-Click on My Computer and Select Manage.  Expand the Services and Applications Tree in the Computer Management Dialog.  Select the Services entry.  In the right-hand window, Right-Click on the PTW Service and Select Properties.  In the PTW Service Properties Dialog, Select the Log On tab.  Under the Log on as: section, Select the This account radio button.  Browse to the JMPS Unique User you set up in the earlier step (“Configure the Machine for COM+”).  Type in the Password you set up for that user in the Password and Confirm Password text boxes.  Click Apply and then OK.

6. JC1/JCP Server Shares:  If you selected to install onto a JMPS data Server during the install, the Install should create two share folders and update the Configuration Database to reflect these shares. However, you may want to verify that they are set (the shares are not being set on COE configured machines).  Navigate to the JC1/JCPProgramInstallDirectory\jmps\data directory and select properties from the drop down menu. Click on the Sharing tab and click the Share this folder radio button. Type in the name Data in the Share Name field. Click OK.  Next, navigate to the JC/JCP1DataInstallDirectory\data\local\jmps\data directory and select properties from the drop down menu.  Click on the Sharing tab and click the Share this folder radio button. Type in the name JMPSData in the Share Name field. Click OK.  The configuration database should have been updated to use these share paths. If you find the data is not available on clients then, once JMPS is up and running on the Server you must modify the data items that you want available to Server Walkaway to point to the new shared path name.  On the Server, in the JMPS Explorer, right click each data item to share and select Modify. Browse to the data item as if you were going through the network. The pathname should look like \\ServerName\JMPSData\... (The following is a list of candidate items: ACOs, ATOs, CMF Tool, Drawing, GPS Trail, Local Routes - JMPS Format, Manual Chum, WaterPages).
7. Configuring Email Notification:  A new procedure for configuring JMPSAdministrator to receive Email notification upon specific JMPS Errors is in place.  Place the email address of the selected administrator in the Registry in the HKEY_LOCAL_MACHINE\Software\JMPS\AlertAdminEmailAddress field. (see section 7.7- Configuring Email Notification)

8. Active Directory:  Set up and configure Active Directory, for those machines that are running as a Domain Controller (see section 7.9 - Configure Active Directory).

9. Security Lockdowns:  During the installation, if Apply Security Lockdowns was selected, permissions were set on JMPS directories.  One of the groups given permissions is “Authenticated Users.  To test in an Operational (Locked-Downed) environment, the file permissions must be manually reset to remove access for Authenticated Users and provide access for the appropriate JMPS groups.  See the Trusted Facility Manual for the section on Controlling Data and File Access in Appendix L.

7 Detailed Instructions

The following sections provide the detailed instructions for selected steps listed above.

7.1 Installing the Java Development Kit (JDK)

Table 7‑1 Installing the JDK

	Step
	What You Do
	Installation Screen

	1 
	Navigate to JDK1.3.1_02 directory either on the install CD or on your hard drive.  Double click on the j2sdk-1_3_1_02-win.exe.
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	2 
	On the Welcome screen, click Next
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	3 
	On the Software License Agreement screen, click Yes (if you accept the license agreement).
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	4 
	On the Choose Destination Location, you may browse to a new destination location or click Next to accept the default location.
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	5 
	If you choose to install to a different location, then select the location and click OK.  On COE machines, you should install to the “D” drive (D:\jdk1.3.1_02).
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	6 
	Accept the remaining defaults. On the Setup Complete window, click Finish.
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7.2 Installing JC1/JCP

You will first install the program (in two parts and with four COM + components) and then the data (in two parts). If you are installing from CD and get an error message saying Error Cannot find Data.cab, then copy the install file to your hard disk and install from the hard drive (some machines have a security feature restricting the install from CD, usually COE).  JC1/JCP will also install MSDE with SP2 if a version of MSDE is not already installed.  (If MSDE 200 SP3 is installed as the JMPS_SQL_Server, it will be used).  If you have an earlier version of MSDE, please uninstall it and JC1/JCP will reinstall it automatically.  If you have a version named machinename/JMPS_SQL_Server already installed, then JC1/JCP will use it.  

Table 7‑2 Installing JC1

	Step
	What You Do
	Installation Screen

	1 
	Navigate to the JC1/JCP Install directory on your hard drive, Build JC1/JCP-buildno.  Double click on the JMPS directory.  Double click on Setup.exe to launch the install.  (If you are installing from a CD, copy the JC1/JCP Install directory to your hard drive first.  If you are downloading from the WEB, download and un-PGP the file using the PGP pass phrase supplied via e-mail and then un-zip it).
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	2 
	On the JMPS Combat 1 Setup screen, click Next.  (This first part, installs the program files, latter you will install the data).
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	3 
	On the License Agreement screen, select the I accept the terms in the license agreement radio button and click Next (if you accept the terms).
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	4 
	On the Client vs. Server screen, select the Client radio button, if you are installing on a client.

Select the Server radio button, if you are installing on a machine that will function as the JMPS data server.  Then click Next to continue with the install.
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	5 
	On the COE Security Settings screen, select the Yes radio button, if you want to apply the Security settings (Lockdowns).  They will not be removed during uninstall.  Select the No radio button if you do not want to apply the Security settings.  Then click Next to continue with the install.
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	6 
	On the Setup Type screen, click next to accept the default (Complete) setup.  This installs JC1 to the default directory (D:\Program Files\JMPS if a D hard drive exists otherwise C:\Program Files).  Or, check the Custom radio button and then click next to specify a custom directory. 
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	7 
	If you selected a Custom setup type, click the Change button, to select a different location to install JC1 to. Select/deselect the features you want.  You may choose to deselect flight performance modules that you will not need. 
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	8 
	On the Ready to Install the Program screen, click Install, if you are ready to install.  Otherwise, click back to change any of your selections.  Click Cancel, if you want to abort the Install.
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	9 
	The Installing JMPS_Combat1 screen shows the status of the install process for the JC1 Program.  A second screen will appear showing the progress of remaining Combat1 program features.
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	When the  program portion of the install completes, click Finish.
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	Once the JC1 Program install completes, the JC1 Data Install starts automatically.  On the JC1 Data Install screen, click Next to proceed with the Data Install.
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	12 
	On the Setup Type screen, Click Next to accept the default Data Install location (E:\Data\local\JMPS\data\if the E hard drive exits, otherwise C:\Data\local\JMPS\data\), or select the Custom radio button and then click Next, to specify a different install location.  If you are installing on a JMPS server, select Custom install, to specify a shared data directory.  (Skip to step 14 if you chose Complete.)
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	13 
	If you selected Custom setup type from the previous screen you will see the Custom Setup screen.  Select Change on the Custom Setup screen to specify a new install location.  Then click Next. 
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	14 
	On the Change Current Destination Folder screen, if you wish to change the destination folder, navigate to the new folder and click OK.  
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	15 
	On the Ready to Install the Program screen, click Install to proceed with the Data Install, click Back to change any of your settings, or click Cancel to abort the Data Install.
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	16 
	If you selected the install button, you will see a status window for the Data Install.  A second screen will appear showing the progress of remaining Combat1 data features, including the progress of extracting the Climatology data.  (This takes 5 + minutes).  After the data is installed, if you do not have MSDE installed as the JMPS_SQL_Server, then the install will install it.  If a dialog(s) titled Digital Signature Not Found is displayed, then click continue with the install.  This may display up to six times and is associated with COE lockdowns.
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	17 
	When the Data is installed and the Climatology data has been extracted the Completing the JMPS-Combat1-data-Setup wizard screen appears.  Click Finish.  JC1 is now installed.
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7.3 JMPS Security Role Configuration Instructions for the Development Environment

7.3.1 Background  

These instructions are intended for the JMPS development/test community to ensure they can operate JMPS with security Role and Privilege checks implemented.  The full security configuration instructions will be included in the Trusted Facility Manual (TFM) and Security Features User’s Guide (SFUG), which are under development.  

JMPS will check that users have particular roles to perform particular functions within JMPS.  To be able to run JMPS, a user must have one of the 4 unique JMPS roles.  There are also some functions within JMPS that require a specific privilege.  Both Role checks and Privilege checks are performed using Windows Groups.   Thus the System Administrator must set up Windows Groups for all Roles and Privileges defined for JMPS, either on the domain or on the local machine.   

JMPS follows these basic rules when checking Roles and Privileges:

 

· First it will look on the Domain that the user is logged into for a group that matches the Role/Privilege that has been requested.  If it finds the group then it will check for this user within that group.  If the user is in the group, then the user has the Role/Privilege, else the user does not.  This means that even if the user has local permissions they will be ignored, if the groups are defined on the Domain and the user does not have domain permissions.

· If JMPS DOES NOT find that group at the Domain level, then it will look to the local machine to try to find that group.  If it finds the group then it will check for the user within that group.  If the user is in the group, then the user has the Role/Privilege, else the user does not.

In deployed situations it is anticipated that the groups will be added to the domain in which the JMPS user exists, but these instructions add the groups only to each local machine.   Note that the process is essentially the same for adding the groups to the domain, except that it requires a user have privileges on the domain, and perform these functions on the domain rather than the local machine.  JMPS first checks the domain for the existence of a group, and then falls back to the local machine if no domain group is located.  If it is possible within your domain to add these groups, it will simplify the administration if a user runs on a different machine.  If you do not have privileges to add groups to the domain (common on most corporate networks) then add the local groups as outlined in these instructions.  Since this must be done on each machine, if there is a need for multiple users to run JMPS on a given machine, all of those users must be added to JMPS groups on that machine.  

The Roles are:

	JMPS_ADMINISTRATOR_ROLE
	Authorized to set group preferences, and establish other system configuration settings that are not security related.

	JMPS_DATABASE_ADMINISTRATOR_ROLE
	Authorized to load, modify, and delete common database files, e.g. Intel and NIMA products.

	JMPS_SECURITY_ADMINISTRATOR_ROLE
	Authorized to perform all security related operations including audit data management and user account management.

	JMPS_MISSION_PLANNER_ROLE
	Authorized to perform all JMPS operations which are not otherwise restricted to the above roles


The Privileges are:

	JMPS_DOWNGRADE_PRINTED_OUTPUT_CLASSIFICATION_PRIVILEGE
	Authorized to modify the classification for printed output material.

	JMPS_COLLABORATION_PRIVILEGE
	Authorized to plan missions in collaboration mode


7.3.2 Setting up Local Groups:

Note:  You must belong to the Administrator group to perform the steps below.  The groups listed below will have been added to the local machine during a JC1 install, if they did not already exist.  You must now add your users to the appropriate groups.

JmpsAdministrator

JmpsDataBaseAdministrator

JmpsSecurityAdministrator

JmpsMissionPlanner

JmpsDowngradePrintedOutputClassification

JmpsCollaboration

5. Select Start->Settings->ControlPanel

6. Double Click on Administrative Tools

7. Double Click on Computer Management

8. Within the Computer Management dialog, if needed, expand System Tools

9. If needed, expand Local Users and Groups

10. Select Groups

11. Double Click on the group you wish to add users to.

12. Click on the Add button

13. Within the "Select Users or Groups" dialog, double click on users from the list box to add them to the group.  Likely, most testers will want to belong to JmpsMissionPlanner and JmpsDataBaseAdministrator.  This will allow access to most JMPS capabilities including loading DAFIF/MAPs, with the exception of Administrative Preferences and Security Administration capabilities.  

Note 1: You may need to change the entry in the "Look in:" drop down list to point to where the desired user account lives (local machine, domain, ...)

Note 2: If you know the users name, you can enter it in the lower box.  (e.g., northgrum\squilth would add the user squilth which resides in the northgrum domain.)

14. When you are done adding users to this group, select the OK button on the "Select Users or Groups" dialog to close it.

15. Select the Apply button on this Group’s Properties dialog to apply these changes.

16. Select the Close button on this Group’s Properties dialog to close the dialog.
17. Repeat steps 7-12 for each group you wish to add user’s to.

7.4 Set COM+ Communication Properties

JC1 includes COM+ components in its delivery.  In order for JC1 to run on your machine, you must change the default COM+ authentication property to none. In addition, COM+ application properties must be set to enable JMPS to run when the logged in user is neither a local nor domain administrator.

7.4.1 Setting the Default COM+ Authentication Level

Note: You must belong to the Administrator group to perform the steps listed in Table 7-3 below.

Table 7‑3 Setting the Default COM+ Authentication Level

	Step
	What You Do
	Installation Screen

	1 
	Go to the Start menu and navigate to Start\Settings\Control Panel\Administrative Tools\Component Services.

When you have the Component Services dialog open, expand the component Services tree in the left windowpane.
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	2 
	Right click on My Computer and select Properties.  Then select the Default Properties tab.  Under Default Authentication Level: select None.  
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	3 
	Click the OK button. Do not close the Component Services window yet.
	


7.4.2 Setting a JMPS Unique Windows User

The COM+ applications installed as part of JMPS may be required to run whether or not a user is currently logged in on the JMPS workstation.  In addition, the privileges required by the JMPS COM+ applications may exceed those of the currently logged in user. Therefore, it is necessary to create a user with a specific privilege level, and to set specific JMPS COM+ applications to run as that user.

To set a JMPS Unique Windows User for a single machine, see Table 7‑4.

To set a JMPS Unique Windows User for a Local Area Network on the Domain Controller, see Table 7‑5.

To set a JMPS Unique Windows User for a Local Area Network on the Workstations, see Table 7‑6.

Note:  You must belong to the Administrator group to perform the steps below.

Table 7‑4 Setting a JMPS Unique Windows User for a Single Machine

	Step
	What You Do
	Installation Screen

	1 
	Go to the Start menu and select Start\Settings\Control Panel.

In the Control Panel window, select Administrative Tools.

In the Administrative Tools window, select Computer Management.

In the Computer Management window, browse to System Tools\Local Users and Groups\Users.

Right click on Users and Select New User... from the drop down menu.
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	2 
	In the New User dialog, enter JMPS as the user name in the User name text field and an optional Full name and Description for the user.

Enter a Password, and Confirm password.

For COE machines the password must contain the following:  a capital letter, a numeral, a special character, and at least 8 characters.

Remember the user name and password for use in configuring the JMPS COM+ applications.

Click the Create button to create the user.

Click the Close button to close the New User dialog
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	3 
	Highlight Groups under Local Users and Groups in the left windowpane.

Right click on Administrators in the right windowpane and select Add to Group from the drop down menu.
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	4 
	Click Add… on the Administrators Properties window.

Scroll to the JMPS user you previously created, highlight this user, and Click OK on the Select Users or Groups Window.  Click Add.

Click OK on the Administrators Properties Window.

Exit the Computer Management and Administrative Tools dialogs by clicking on the X in the upper right hand corner.
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Table 7‑5 Setting a JMPS Unique Windows User for a Local Area Network on the Domain Controller

	Step
	What You Do

	1 
	On the domain controller of the network, go to the Start menu and navigate to Start\Settings\Control Panel\Administrative Tools\Active Directory Users and Computers.

	2 
	Right-click on Users and select New->User.

	3 
	In the Full name field, type “JMPS”.

	4 
	In the User logon name field, type “JMPS”.

	5 
	Click on the Next button.

	6 
	Enter a password in the password fields.  

For COE machines the password must contain the following:  a capital letter, a numeral, a special character, and at least 8 characters.

	7 
	Check the Password never expires checkbox.

	8 
	Click on the Next button.

	9 
	Click on the Finish button.

	10 
	If you want to run JMPS on the domain controller, you must create another JMPS Unique Windows User.  Otherwise skip to the next section.  

	11 
	Repeat steps 2-9 for a username “JMPSDOMAIN”.

	12 
	Click on the Builtin folder and double-click on the Administrators group in the right windowpane.

	13 
	Click on the Members tab.

	14 
	Click on the Add… button.

	15 
	Select the JMPSDOMAIN user and click on the Add button.

	16 
	Click on the OK button.

	17 
	Click on the OK button in the Administrators Properties window.

	18 
	Close the Active Directory Users and Computers window.


Table 7‑6 Setting a JMPS Unique Windows User for a Local Area Network on the Workstations

	Step
	What You Do

	1 
	For each workstation in the LAN, you must add the user created in Table 7-5, steps 2-9, to the local machine’s Administrators group.  To do this go to the Start menu and navigate to Start\Settings\Control Panel\Administrative Tools\Computer Management.

	2 
	Expand Local Users and Groups and click on Groups.

	3 
	Double-click on Administrators in the right windowpane.

	4 
	Click on the Add… button.

	5 
	In the Look in: field select the domain controller machine.

	6 
	Select the JMPS user and click on the Add button.

	7 
	Click on the OK button.

	8 
	Click on the OK button in the Administrators Properties window.

	9 
	Close the Computer Management window.


Once the JMPS unique windows user is created, set the default COM+ Authentication level.
7.4.3 Configure the JMPS COM+ Applications

Note: You must belong to the Administrator group to perform the steps below

Table 7‑7 Configure the JMPS COM+ Applications

	Step
	What You Do
	Installation Screen

	1 
	In the Component Services window, browse to Component Services\Computers\My Computer\COM+ Applications.
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	2 
	Right-click on each of the following JMPS COM+ applications (Data Change Notification, Event Subscription, and Remote Subscriber Proxy), and select Properties.

On the Identity tab, select the “This user” radio button. This will enable the User, Password and Confirm Password fields.

Click on the Browse… button.

If you are installing JMPS on a LAN then in the Look in: field select the domain controller machine.  If you are on the domain controller, then select the JMPSDOMAIN user and click on the OK button.  If you are on a workstation, then select the JMPS user and click on the OK button.

If you are installing JMPS on a single machine, then leave the Look in: field as it is, select the JMPS user, and click on the OK button.

Enter the Password and Confirm password for the JMPS unique user created earlier.

Click the OK button.  Repeat for each COM+ application listed above.

Exit Component Services and Administrative Tools by clicking on the X in the upper right hand corner.

You must reboot your computer to establish these settings.
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7.5 Install and Configure the FTP Server

This procedure should be performed only on the hosts that will act as JMPS PTW servers. Typically, this will be only the JMPS server.

Make sure your Windows OS disk(s) is available before starting this procedure.

7.5.1 Install the FTP Server

Table 7‑8 Installing the FTP Server

	Step
	What You Do
	Installation Screen

	1 
	Start\Settings\Control Panel

Click Add/Remove Programs

Click Add/Remove Windows components

Select Internet Information Services (IIS)

Click Details…
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	2 
	Select File Transfer Protocol (FTP) Server. This selects Common Files and Internet Information Services Snap-In

Click OK

Click Next

The system may ask you to insert your Windows OS disk.  Do so

Click OK
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7.5.2 Configure the FTP Server

Table 7‑9 Configuring the FTP Server

	Step
	What You Do
	Installation Screen

	1 
	Click Start\Run…

Enter mmc, and press return or click OK.
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	2 
	On the Microsoft Management Console window’s main menu select Console\Add/Remove Snap-In… from the Console drop down menu.


	[image: image36.png]Tree | Favortes |






	3 
	On the Add/Remove Snap-In dialog, click the Add… button
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	4 
	On the Add Standalone Snap-In, select Internet Information Services by double clicking, or single clicking and then clicking the Add button

Click the Close button.
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	5 
	On the Add/Remove Snap-In dialog, click the OK button.
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	6 
	Using the Console Root window, browse to the Default FTP Site entry. You may need to click on your local machine name entry before the Default FTP Site entry will appear.
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	7 
	Right-click the Default FTP Site entry and select Properties. 

On the FTP Site tab, change the Description to PTW FTP Site.
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	8 
	On the Security Accounts tab, check the Allow Anonymous Connections check box. PTW uses anonymous FTP to send the requested products back to the JMPS PTW server.


	[image: image42.png]FIF S Secuy Acctrts | essages| Home Dieco | Diecon Securty |

ey Caadions
Selectthe Windows User Account o us forancnymous soces o tis resource

Usemame:  [U5R_LLCATMCCLEDE Browse.

Eassiord
I~ Allow oy anorymous comnections.

IV Allog 115 to control password

[-FTP Site Operators
(Grant opeatar ryieges o Windaws Use: Acsauts fo this FTP it crl,

Al

Operators

Bemove.

Cancel Apply Help






	9 
	On the Home Directory tab, set the Local Path in the FTP Site Directory text box to a folder on the local system that has sufficient space to handle PTW imagery.  Check the Read, Write, and Log visits checkboxes.

Remember the Local Path setting for the FTP server. This path must be used as the value for the Push Path when configuring the JMPS PTW Server.

On the Default FTP Site Properties, click the OK button.
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	10 
	On the Console window, select Console\Exit.

If you click No, when asked whether to save console settings, you will need to reload the Internet Information Services Snap-In each time you run MMC. If you click Yes, when asked whether to save console settings, the console settings will be saved on the Desktop with a default name. Select Cancel when asked whether to save console settings if you want to save the settings somewhere else, or with a different name. Then, on the Console window, select Console\Save As…
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7.6 Setting up Roaming Profiles on the Server

When using roaming user profiles, users can log on to any computer that is running Windows 2000 within the user's domain. After they log on, all of the user settings and documents they stored on the server in the roaming user profile copy to the local computer. Users can run applications, modify documents, and work on the computer as they normally would until they log off. When a user logs off, the user profile is copied to a server. When the user logs on to another computer, all of that user's profile information is copied to the second computer.

1. If there isn’t a shared folder set up for roaming profiles on the Server, then create one.

2. To create a shared folder, go to the drive on the server where you want the folder to be created using Windows Explorer.  In the File menu go to New and select Folder.

3. Type in a name such as “RoamingProfiles” for the new folder’s name.

4. Right-click on this folder and select Sharing…

5. Select the Share this folder option and make note of the Share name (Share name).  

6. Click OK.

7. Now click on the Start menu, go to Settings, and select Control Panel.

8. Double-click on Administrative Tools.

9. Double-click on Active Directory Users and Groups.

10. Double-click on the user you want to set up a roaming profile for.

11. Click on the Profile tab.

12. In the Profile Path field type “\\<servername\Share name\user name”, then click OK.

13. Close the Active Directory Users and Groups window.

14. If your user was logged in one of the workstations during this process, then you must log out of that workstation and log back in.

7.7 Configuring Email Notification

Certain components within JMPS have the ability to notify JMPS Administrators when specific errors occur.  In order to receive these notifications, you must:

1. Belong to the JMPSAdministrator group.  This may require assistance from your Domain Administrator.

2. Have an email address associated with your user information in Active Directory.   This may also require assistance from you Domain Administrator.

3. You will need to set a registry entry on your workstation specifying the location of the JMPS Security Groups (JMPSAdministrator…) within your particular facility’s Active Directory hierarchy.  This information may need to be retrieved from your Active Directory Domain Administrator.

Note: This instruction walks you through setup #3.  It does not cover adding your account to the JMPSAdministrator group nor does it cover adding your email address to your user record.  Again, you should consult you Active Directory domain administrator to handle these items.

Table 7‑10 Configuring Email Notification

	Step
	What You Do
	Installation Screen

	1 
	As a Windows administrator select the Start menu and then the Run… option to bring up a Run dialog.

Enter regedit in the text box and select the OK option to bring up the Registry Editor.
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	2 
	Within the Registry Editor, navigate down to MyComputer\HKEY_LOCAL_MACHINE\SOFTWARE\JMPS.
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	3 
	If a key (folder) with the name of ActiveDirectory already exists, then proceed to step 5.

Otherwise, right mouse select the JMPS key (folder) and select New->Key from the cascading  menu.  This will create a new key (folder) with the name of “New Key #1”.  
	[image: image48.png]Registry Editor

Regstry Edt View Favortes Help
"0 InstalledOptions
{2 mstalshiskd

0 mreL

{2 Javasoft
g

Collapse |

Find

String Value
Delete Binary Value
Rename DWORD Value.

Copy Key Neme
o

= nevsonbiees
[y ComputerHKEY_LOCAL_MACHINEISOFTWARELINPS.






	4 
	While this text is highlighted, rename it by typing ActiveDirectory and then tapping the Enter key.  This will create and ActiveDirectory key (folder) under JMPS.
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	5 
	If a key (folder) with the name of "JmpsRolesHomeDN already exists, then proceed to step 7.

Otherwise, right mouse select the ActiveDirectory key (folder) and select New->String Value from the cascading menu.  This will create a new string value with the name “New Value #1”.
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	6 
	While this text is highlighted, rename it by typing JmpsRolesHomeDN and then tapping the Enter key.  This will create a JmpsRolesHomeDN value under ActiveDirectory.
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	7 
	Right mouse select JmpsRolesHomeDN and select the Modify option to bring up the Edit String dialog.
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	8 
	Enter the binding string that defines where the JmpsAdministrator security group resides within your Active Directory hierarchy and select the OK option to close the dialog.  You will need to speak with your Active Directory administrator to find out this information.

NOTE: The value entered here is a sample and was the string required on our test lab computers.

Close the Registry Editor by selecting the close (X) icon in the upper right corner of the Registry Editor dialog.
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7.8 Installing Microsoft Message Queue

Microsoft Message Queue (MSMQ) enables applications to communicate with each other via messages.  These messages are sent into a queue, to be processed by receiving applications.  MSMQ is required to be installed prior to installing JC1 or the JC1 install will fail.

Table 7‑11 Installing Microsoft Message Queue

	Step
	What You Do
	Installation Screen

	1 
	Select the Windows Start button and navigate to the “Settings/Control Panel” option.  Select Add/Remove Programs.
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	2 
	From the Add/Remove Programs dialog, select Add/Remove Windows Components from the left hand side.
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	3 
	From the Windows Components Wizard dialog, select Message Queuing Services and press Next.
	[image: image56.png][ Windows Components Wizard E

Windows Components
You can add or remove components of Windows 2000

To add or remove  component, lck the checkbor. 4 shaded bos means that only
part of the component wil be nstaled. To see whal's included n a companen, cick
Detals

Comporents:

01 96 Intemet Infomation Servces 15)

5 23Management and Monkoing Toos oams
8 Message Quting Sevces 26m8
1 2 Netwerkin Servines niwe =l

Descipton: Enables fast ultest searching of fes.

Tota disk space requied: 0118

Detls
Space avaiable on disk: 19075.2MB

Bk Cance






	4 
	From the Message Queuing Type dialog, select Independent client and do not check the Manually select access mode to Active Directory check box. Then press Next.
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	5 
	From the Message Queuing Server dialog, select the Message Queuing will not access a directory service option and press Next.
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	6 
	If the installation process requests source media, insert your Windows 2000 Professional CD, select OK, and follow the on-screen prompts.  Or see step 7.
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	7 
	Optionally, if you have access to the in-house Northrop Grumman JMPS server you may Browse to \\casp-jmps-srv\APPS&TOOLS\Microsoft\Win2k Pro\I386.  Then select OK.
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	8 
	When the installation is complete, select Finish.
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	9 
	To use MSMQ you will have to restart your computer.
	


7.9   Configure Active Directory

Active Directory Tools required:

1. Active Directory Schema Management Snap-in:  

2. ADSI Edit tool:  The ADSI Edit tool is another snap-in for MMC that allows you to browse the directory partitions easily and retrieve attribute-level information from objects.  This tool is installed with the Windows 2000 Support Tools (Support\Tools\Setup.exe) on the Windows 2000 Server or Windows 2000 Advanced Server CD-ROM.

There are 3 methods of expanding your Schema:

1. Manually using the Active Directory Schema snap-in

2. Manually using import files

3. Programmatically using an installation program

Since we will be adding only a few attributes, we shall use the first method (Manually using the Active Directory Schema snap-in).  We will be adding 2 custom attributes to the schema.

7.9.1 Add Custom Attributes to Schema

1. First Locate the Schema Master for the Forest. If you are not sure who it is, then you can use netdom.exe from the Resource kit.

C:\WIN2K\system32>netdom query fsmo

Schema owner                
win2k.crisco.com

Domain role owner           
win2k.crisco.com

PDC role                    

win2k.crisco.com

RID pool manager            
win2k.crisco.com

Infrastructure owner        
win2k.crisco.com

The command completed successfully.
2. Once you have logged into the console of the Schema Master, you need to register the Active Directory Schema tool from the command line run:

1. Search for the location (folder) that contains schmmgmt.dll.  The file schmmgmt.dll usually is located at c:\WINNT\System32

2. Type: cd c:\WINNT\System32

3. Run: regsvr32 schmmgmt.dll

This will result in the following message: (see Figure 1)
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Figure 1. RegSvr32.

3. Now you can run the Active Directory Schema Snap-in. Click on start Run and type: schmmgmt.msc.  The Active Directory  Schema Snap-in dialog pops up. (see figure 3).

4. You need to ensure that the Schema can be modified on this Domain Controller by doing the following steps: 

· Right Click on Active Directory Schema and go to Operations Master…. 

· Then the Change Schema Master shows up (see figure 18).  Make sure to select the checkbox “The Schema may be modified on this Domain Controller.” (see figures 2 & 3 below) and click on OK button to close the dialog.
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Figure 2. Console1.
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Figure 3. Change Schema Master.

5. It is time to add 3 custom attributes:  On the Schema Management Snap-in dialog, Right click on Attributes and go to New -> Attribute.   You will get a warning that this operation cannot be undone (see figure 4), click Continue button to close the warning dialog and then a Create New Attribute dialog pops up (see figure 21):
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Figure 4. Schema Object Creation.

6. Now enter information (Common Name, LDAP Display Name, Unique X500 Object ID, Syntax) for the  3 new custom attributes: (MDBName, MDBUpload and Location)  (see figures 5 and 6 for examples of MCBName and MDBUpload). For values of Unique X5000, please see explanation in appendix A. 
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Figure 5. Create New Attribute.
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Figure 6. Create New Attribute.

7. You must now associate the 3 new custom attributes you just created, with the Computer Class.  From the Schema Management Snap-in dialog (see figure 7 & 8),

· Expand the Classes  column and right click on the Computer Class and click on Properties. 
· On Computer Properties dialog, click on the Attribute Tab.

· Click on the Add button.  The Select Schema Object dialog shows up.
· On the Select Schema Object dialog, locate the 1st  new custom attribute (mDBName) you wish to link to the Computer Class and then Click on OK.

· Repeat the previous step for the 2nd and 3rd new custom attributes (mDBUpload and Location).

· Once that is completed, 3 new custom attributes shall be seen in the Optional listbox of Computer Properties dialog.

· Click OK button on the Computer Properties dialog.
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Figure 7. Select Schema Object
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Figure 8. Computer Properties

7.9.2 Enter values for the 3 custom attributes:

1. At the command prompt, type ADSIEdit.MSC.  You should see ADSIEdit come up.
2. Expand the Domain NC and locate a Computer Object (or create a new one in Active Directory Users and Computers).
3. Once you find a computer object, right click on it and go to Properties. You will see a window like the one below (see figure 9).

4. Click on the drop down window for “Select a Property to View”.
5. Locate the new attribute you just associated with Computers; in this case I call it MDBName.
6. Populate the Attribute with the value you desire.

· For instance, we install JMPS application at  STATION1-COE machine.  The following steps shows how to configure and enter new values for MDBName on the STATION1-COE machine.

· Now search for the path of the database file configuration.mdb on this machine.  Usually, it is installed at: 

· c:\Program Files\JMPS\data\configuration.mdb.

· Make sure to share the directory c:\Program Files\JMPS\data\ and give permission to EveryOne as (Full Control=yes, Change=yes, Read=yes)

· Now enter the value :\\STATION1-COE\\data\\configuration.mdb into the Edit Attribute field. (See figure 9)

· Next, click on the Set button and you are done.

7. Locate the second new attribute you just associated with Computers, MDBUpload.

8. Populate the Edit Attribute for MDBUpload.

· Create a directory Upload as followed c:\Program Files\JMPS\data\Upload on STATION-COE machine.

· Now enter the value: :\\STATION1-COE\\data\\Upload\\ (See figure 10)

· Next, click on the Set button and you are done.

9. Locate the third new attribute you just associated with Computers, Location.

10. Populate the Edit Attribute for Location.

· Determine a string which best describes the location of the JMPS Server.  For example, “Second Floor, Room 222, East Bay”

· Now enter the value: Second Floor, Room 222, East Bay

· Next, click on the Set button and you are done.
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Figure 9. Station COE Properties
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Figure 10. Station COE Properties

8 Trouble Shooting

1. If JC1 or JMPS has been loaded on the machine before and JC1 does not come up after you complete the above steps, you may have to delete some preference data. 

· Navigate to Documents and Settings\your user name\Application Data\JMPS and delete everything in this folder.

· Navigate to the data folder where you installed JMPS, to the \data\local\JMPS\data\Map_Data_Manager and delete everything in this folder. This will delete your maps. If you want to save old map data, you can try renaming the directory, running JC1 and then copying selected map data one at a time into the newly created folder.

2. If you get an error message saying you do not have permissions to run JMPS, then you have not set up the JMPS Security Roles.  See the attached JMPS Security Role Configuration Instructions. 

[image: image70.png]



Figure 11. Security Check Failed.

3. If, while you are attaching databases in the MSDE, you get the following message:
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Figure 12. Attachable Database Error.

Then delete the DAFIF log file (or the appropriate log file in the appropriate directory).  It is located in the directory you installed your data to, under DAFIF\DAFIF_log.LDF.  For instance C:\data\local\JMPS\data\DAFIF\DAFIF_log.LDF.

4. If, while you are attaching databases in the MSDE, you get the following message:
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Figure 13. Attachable Database Error.

You may disregard this error message as long as all of the databases (Aimpoints, DAFIF, JTIDS, LocalPoints, MissionBinder, OrderOfBattle, PointExtract, and ThreatParameters) were attached.  If one of these databases was not attached, this may also be a database log problem.  Identify which database was not attached and navigate to the dataInstallDir\data\local\jmps\data\databasename and delete the databasename_log.ldf file. Then reattach the database using MSDE.

5. If, while starting JC1, you get the following message:
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Figure 14. JMPS Security Error Dialog

The Event Viewer log files have not been set to overwrite as necessary, (see section 4 - Pre Setup)

6. If you are not running on a COE machine and while starting JC1, you get the following message:
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Figure 15. DII-COE Classification Error Dialog

Then you have not registered the JMPSSecurityUtilitiesStub.dll  This is available on the China Lake site under UPC Devlopers/ToolsTestbed/Developer Security and Privilege stubs.  Do not register the Privilege stub located in the same folder.

7. The MissionBinder components have been changed so that MissionBinders runs in its own process as a COM + Component.  There is a new COM + component that gets installed - MissionBinderRepository.  If when running MissionBinders you encounter an error, you may not be able to run MissionBinders again until you shut down the MissionBinderRepository COM + event. If you get the following error message:
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Figure 16. Invalid Data Source Error

Exit JMPS, then navigate to the Start/Settings/Control Panel/Administrative Tools/Component Services dialog.  Expand the Component Services tree.  Expand the Computers tree.  Expand the My Computer tree.  Expand the COM+ Applications tree.  Right click on the MissionBinderRepository entry and select Shut Down.
Appendix A:
OIDs and what are they : 
 

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/netdir/ad/object_identifiers.asp
 

Object Identifiers (OIDs) are unique numeric values, issued by various "Issuing Authorities" to uniquely identify data elements, syntaxes, and various other parts of distributed applications. OIDs are found in OSI applications, X.500 Directories, SNMP, and other applications where uniqueness is important. OIDs are based on a tree structure, in which a superior issuing authority (such as the ISO) allocates a "branch" of the tree to a subauthority, who in turn can allocate subbranches.

  

Get an OID from Microsoft Corporation:
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/netdir/ad/obtaining_an_object_identifier_from_microsoft.asp
 

Object Identifiers (OIDs) can be obtained from, and registered with Microsoft by going to the following URL:

 

http://msdn.microsoft.com/certification/ad-registration.asp
 

Click on "please register now". On the Registration page, read the instructions, and then fill out the form for registering your OID. If you want Microsoft to generate the OID for you, simply leave blank that entry on the form.

 

No matter what source is used to get the OID, if you intend to extend the Active Directory schema and wish to apply for the Certified for Windows logo, you must register your OID with Microsoft. 

 

If a base OID is obtained, some care should be used in designing how the OIDs should be divided into categories, since these OIDs are contained in the prefix table and are part of the DC replication data. It is recommended that no more than two OID categories be created.

 

For example, if you were assigned the base OID of 1.2.840.113556.1.8000.586, you might create categories in the following manner:

 

a) For Application Attributes:

1.2.840.113556.1.8000.586.1.1
(for 1st custom attribute)

1.2.840.113556.1.8000.586.1.2
(for 2nd
custom attribute)

1.2.840.113556.1.8000.586.1.3
(for 3rd custom attribute)

and so on….




b) For Application Classes:

1.2.840.113556.1.8000.586.2.1
(for 1st custom class)

1.2.840.113556.1.8000.586.2.2
(for 2nd custom class)

1.2.840.113556.1.8000.586.2.3
(for 3rd custom class)

and so on…

Something you may want to consider, is to replicate these attributes in the Global Catalog, or to Index them. Both of these actions come at a cost, but improve the search performance for often accessed attributes. If you right click on the attribute you just created you will see these options made available to you.
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